CONTENTS

0. Introduction .......................................................................................................................... 1
  0.0. About this guide .............................................................................................................. 1
    Version information, and suggested citation and copyright ............................................. 1
    Comments and suggestions ................................................................................................. 1
    Required Software ................................................................................................................ 1
    Conventions used in this guide ............................................................................................. 1
    Not in this guide..................................................................................................................... 2
  0.1. Reading technologies, and implications for document design ...................................... 3
    The (alternate) user interface .............................................................................................. 3
    Visual versus programmatic formatting .............................................................................. 4
    Implications for the design of documents ........................................................................... 8

1. Producing Accessible Word Documents ............................................................................. 11
  1.0. Preparation ..................................................................................................................... 11
    Views and panes .................................................................................................................. 11
    Showing formatting characters and marks on the document ............................................. 16
    Avoid automatic formatting ............................................................................................... 17
  1.1. Formatting ....................................................................................................................... 19
    1.1.1. Use Styles for formatting ....................................................................................... 19
    1.1.2. Format paragraph line spacing with styles .......................................................... 26
    1.1.3. Use list formatting .................................................................................................. 27
    1.1.4. Use Column formatting ....................................................................................... 29
    1.1.5. Do Not Use Hyphenation .................................................................................... 31
    1.1.6. Do Not Use Drop Caps ....................................................................................... 32
    1.1.7. Convert text boxes to regular paragraphs ............................................................. 33
  1.2. Navigation ....................................................................................................................... 37
    1.2.1. Place document titles in the main document; not the 'Header' area ...................... 37
    1.2.2. Use Heading Levels in style formatting ................................................................. 39
    1.2.3. Use automation if creating a Table of Contents ..................................................... 41
  1.3. Language ........................................................................................................................ 44
    1.3.1. Set the language properties ................................................................................... 44
  1.4. Fonts ............................................................................................................................... 46
    1.4.1. Use System Fonts .................................................................................................. 46
  1.5. Graphics / images .......................................................................................................... 49
    1.5.1. Add Alternate Text to graphics / images ............................................................... 49
    1.5.2. Group Complex Objects ....................................................................................... 53
    1.5.3. Place graphics / images 'in line' .......................................................................... 55
    1.5.4. Avoid (or carefully control) text rendered as images ......................................... 57
  1.6. Tables ................................................................................................................................ 62
    1.6.1. Remove table formatting applied to non-tabular information ................................. 62
    1.6.2. Set the header row as 'repeating' ......................................................................... 63
    1.6.3. Remove text wrapping around tables ................................................................. 65
  1.7. Links .................................................................................................................................. 67
    1.7.1. Assign link names that make sense when spoken in isolation ............................. 67
    1.7.2. Where possible, do not allow links to span two lines of text ............................... 68
  1.8. Color .................................................................................................................................. 69
    1.8.1. Use text colors that contrast with their backgrounds .......................................... 69
    1.8.2. Use automatic color settings for black text and white text .................................. 70
2. Converting from Word to PDF ................................................................. 75
   2.0. Essential concepts ........................................................................... 75
   Easy ways and hard ways to make an accessible PDF ....................... 75
   Conversion is one-way, with no going back ........................................ 77
   2.1. Conversion from Word to PDF ....................................................... 80
       2.1.1. Configure Conversion Preferences ......................................... 80
       2.1.2. Convert the document with the 'PDF Maker' application in Word 85
3. Checking and fixing accessibility issues in PDF documents ............. 87
   3.0. Preparation .................................................................................... 87
       The 'Accessibility Full Check' ............................................................. 87
       The Reflow view ............................................................................. 91
       The Read Out Loud feature ............................................................. 91
       Other guidance and Help ................................................................. 92
       Limited 'Undo' capabilities in Acrobat Pro during accessibility remediation 93
   3.1. Reading order ............................................................................... 94
       3.1.1. The initial view is set properly? ............................................... 94
       3.1.2. The reading order is correct? .................................................. 96
       3.1.3. Lists have the correct tag structure? ....................................... 98
       3.1.4. The tab order of pages is set? ................................................ 100
       3.1.5. Artifacts are correctly placed outside of the reading order? .... 100
   3.2. Navigation .................................................................................... 102
       3.2.1. Bookmarks are set correctly? .................................................. 102
       3.2.2. Headings are set correctly? ...................................................... 102
       3.2.3. Dynamic tables of contents are working? ............................. 104
   3.3. Language ...................................................................................... 105
       3.3.1. The Language(s) have been defined? ..................................... 105
   3.4. Fonts ............................................................................................. 107
       3.4.1. Character Mappings have worked properly? ......................... 107
   3.5. Graphics / images ......................................................................... 108
       3.5.1. Alternate Text is added to Information-Type images? ........... 108
   3.6. Tables ............................................................................................ 109
       3.6.1. Table Tags are set? ................................................................ 109
   3.7. Links ............................................................................................. 112
       3.7.1. Links make sense when spoken in isolation? ......................... 112
       3.7.2. Links (where possible) are on only one line of text? ............. 112
   3.8. Color ............................................................................................. 114
       3.8.1. High-Contrast color combinations are used? ......................... 114
       3.8.2. Color is only used redundantly? ............................................. 115
   3.9. Document properties ...................................................................... 116
       3.9.1. Document properties are properly set? ................................. 116
   Attachments ......................................................................................... 117
       Word Document Accessibility Checklist ......................................... 119
       PDF Document Accessibility Checklist ........................................... 121
       Reader's Notes .............................................................................. 123
       Agency-Specific Information (SSA) ................................................. 125
0. Introduction

0.0. About this guide

Version information, and suggested citation and copyright


This guide is produced by the Social Security Administration Accessibility Resource Center (ARC).

For a suggested citation and copyright status of this document, see the last page of this document.

Comments and suggestions

Please email comments and suggestions on this guide to the ARC at: section508.developer@ssa.gov.

Required Software

For producing accessible Word documents:

- Windows XP or Vista
- Office 2007 (including Word 2007)

For converting Word Documents to accessible PDF (Portable Document Format) Files:

- Adobe Reader
- Acrobat Pro 8.1
  *Important: version 8.1 is a minimum requirement. Version 8.0 will not work properly.
- CommonLook Plug-In for Acrobat Pro

Conventions used in this guide

Menu commands are in bold, and underlined text.

Keystrokes have an outline, e.g.: CTRL+ALT+Delete.
Not in this guide…

- **This is not a guide to using Word and/or Adobe Acrobat Pro:** This guide provides information on how to use certain features in MS Word and Adobe Acrobat Pro in order to make documents more accessible for people with disabilities. This guide is not intended as a replacement for general training on how to use these applications.

- **This is not a guide for producing Braille or Large Print documents:** This guide addresses accessibility-related features of documents for reading on a computer.

- **PDF Forms are not covered in this guide.**

- **An Introduction to accessibility and Section 508:** For a general introduction to accessibility and requirements of Section 508 of the Rehabilitation Act, see the resources and training materials at: The GSA Section 508 website: [http://www.section508.gov/](http://www.section508.gov/)
0.1. Reading technologies, and implications for document design

The (alternate) user interface

Documents can be printed out or read on a computer. Accessibility considerations are important for both print and electronic document formats, but in this guide we are mostly interested in reading documents on computers.

The User Interface is the means by which inputs (controls) are relayed to the computer so that the desired output (display) of information (in this case, document content) is presented to the user.

In regular operation, users can use their eyes, ears, voice and hands to provide inputs and perceive outputs. Typically, the computer screen, audio speakers, keyboard, and mouse are used.

When someone who has a sensory or a physical disability is reading a document on a computer, one or more of the regular input / output capabilities can be diminished or unavailable. For example:

- Someone who is totally blind cannot use their eyes, so they cannot see the screen and they cannot use the mouse (the mouse requires eye-hand coordination). Instead, they can use talking software, called a Screen Reader to hear the information that is ordinarily shown on screen, and they use the keyboard to control the Screen Reader software.
- Someone who has low vision has a diminished ability to use the screen. They can compensate by using Screen Magnification software. Depending on their preferences, they may use a combination of Screen Magnification and Screen Reader software.
Someone who has no ability to use hands may use Speech Recognition software to control the computer. They cannot use the keyboard or mouse, so all commands are spoken (e.g., "Page Up... Page Up... Move to Top...").

The key point is that people with disabilities (PWDs) can use an alternative mode of input and/or output when the ordinary method is unavailable. The words and meaning of the document remain the same, it is only the information delivery and user control mechanisms that differ.

It is important to know that in order for these alternate interface mechanisms to work, the documents need to be designed to be accessible. Attention must be paid to certain design details (covered in this guide) in order to make it possible for technologies such as Screen Readers, Screen Magnifiers, and Speech Recognition Software to be able to work with individual documents. Without attending to these design details, many PWDs will find it difficult or impossible to read your documents.

**Visual versus programmatic formatting**

To a sighted reader of a document, a 'heading' looks like a heading when it is visually formatted differently to other text. Things like centering, bold, underlining and capitalization can all be used to differentiate a chunk of text to look like a 'heading'. Formatting of this kind (bold, underline, etc.) can also be used within paragraphs, to emphasize certain words. The problem for Screen Reader software is that because this type of formatting can be applied in either a heading or a paragraph of text, there is no way for the software to detect which one it is—is it a heading or a regular paragraph?
With a page of text that is laid out with headings differentiated only by visual formatting (bold, underline etc.), the way the Screen Reader software interprets the page is analogous to single, continuous block of text:

It is clear that for a sighted reader, removing the visual formatting of headings makes the page much more difficult to read. But for a non-sighted user, the text is spoken only one word at a time, with no way to skip over sections to the next heading. In fact, when only visual formatting is applied to the text, the Screen Reader can employ only very limited reading commands such as:

- read previous/next word,
- read previous/next paragraph,
- go to the beginning/end of the document.

What is missing is a programmatic identification of headings in the document. This can be applied easily by use of styles in MS Word. The heading can still look the same way as it did before (bold, underline etc.), but some non-visible code gets added to the piece of text that says, (essentially) 'this is a heading'.
In MS Word and in PDFs, heading styles can be applied programmatically. The heading styles can have associated levels, just as with visual differentiation (i.e., level 1, level 2, level 3 etc.) to give a hierarchical structure to a document’s content. When heading styles are applied, the Screen Reader software can, at the command of the user, jump to the next heading in the document:

![Diagram showing heading structure]

Now, with heading styles applied, the list of commands available to the Screen Reader expands to include:

- Jump to next/previous heading,
- Jump to next/previous heading of level $n$,
- Display a list of all the headings in this document.
- Sort the list of headings alphabetically or in the order they appear in the document.
By adding this programmatic formatting, the Screen Reader user can now navigate the document much more easily. In addition to headings, we can enable a large number of Screen Reader controls to work. We can provide comparable access to a document by applying programmatic formatting on other parts of the text, such as:

- Images (graphics)
- Tables
- Bulleted Lists
- Numbered Lists
- Hyperlinks
- etc.

Even the most complex documents can be made easily navigable with a screen reader if the correct styles and formatting are applied. By applying this type of formatting, people who are blind or who have low vision may be able to access and read documents as quickly and as efficiently as their colleagues who have good vision.
Implications for the design of documents

In terms of design, we can sum up the situation as follows:

- Certain physical and/or sensory capabilities of the users will be reduced or unavailable;
- Therefore, we cannot rely on one or more of the regular computer controls and/or displays (inputs/outputs) being available;
- Therefore, we need to change the formatting (programming) in the document so that it works with the technologies that PWDs typically use to interact with computers.

To make documents accessible, the focus of document developers must be on formatting the document so that it works with things like Screen Readers, Screen Magnifiers, and Speech Recognition software. Taking this approach—focusing design attention on the elements in the document itself—has several benefits for you, the document developer:

1. You do not need to make a 'special' document for any one group of users. The document will be readable for everyone;
2. The content of the documents does not need to change. All that changes is the formatting aspects applied to various pieces of text;
3. You do not need to change the visual layout of the document to make it accessible;
4. You do not need to learn how to use technologies that PWDs typically use (if you format the document appropriately, there is a very high probability that it will work for PWDs);
5. You do not need to be a programmer. Although the additional formatting is programmatically applied to text using the MS Word and Acrobat Pro applications as non-visual code, it is not the same sort of task as software programming. All of the tools necessary to add the formatting are included in the MS Word and Acrobat Pro software; and

6. By using formatting of the kind necessary for accessibility, authoring and editing documents becomes a much more rapid process. The reason is that this type of formatting makes moving and changing text easier for any developer. If you want to change the size of the font for every heading in a 200 page document, for example you can do this with a couple of commands. If you want to change the spacing between every paragraph in a long document, you can you can do this in a matter of seconds if you are using styles (programmatic formatting).
1. Producing Accessible Word Documents

1.0. Preparation

The following items are MS Word tools that are useful to know about as preparation for accessibility development tasks.

Views and panes

Document Views

There are five different ways to view a document in MS Word. The different views are accessed by Ribbon... View Tab. The five document views are:

1. Print Layout
2. Full Screen Reading
3. Web Layout
4. Outline
5. Draft

The text that will be (can be) read by a Screen Reader is best represented by the Draft view. If an element such as an image or a text box shows on the screen in Print Layout view, but it does not show in Draft view, then it is highly probable that the element will not be read aloud for the user.
Helpful Panes

MS Word has a number of different window 'panes' that can be helpful to use while developing a document. These panes do not need to be shown at all times—they can be displayed as and when needed. The panes and the means to show the panes are described below:

**Document Map**

This is a 'map' of the structure in terms of the headings that have been applied in the document. When the document is formatted correctly, anything that looks like a heading will show up in this map. The map provides a quick means of navigating to different headings within large documents.

- To view the document map: **Ribbon... View Tab... Show/Hide Group... Document Map.**
**Style Pane**

This pane shows the name of the style that is used for each paragraph in the document.

For example, if a heading is properly used, the style will show 'Heading #' in this pane. If you open the Style Pane and every style says 'Normal' even though there are headings and bullet lists in the document, the document will not be accessible to Screen Reader users.

To show the Style Pane (in Draft View and Outline View only):

1. Open the Word Options dialog box (Office Button > Word Options);
2. Go to **Advanced**, then scroll down to **Display**, and then add a value (e.g., 2") to **Style pane width in draft and outline views**.

3. View the document in **Draft View**: **Ribbon... View Tab...**

**Document Views Group > Draft.**

**Styles Pane**

The Styles Pane is useful for seeing what styles have been applied to text, picking styles to apply to text, and managing styles. Style-formatting is a necessary part of making documents accessible.

To view the Styles Pane:

1. Go to the **Styles Group** of the Ribbon (**Ribbon... Home Tab...**

**Styles Group**):

2. Select the small icon in the bottom right corner of the styles group.

*Note: At first, the Pane may appear as a floating window. To make the position of the pane ‘fixed’, try clicking and holding the menu bar of the pane, and drag it to the right hand side of the screen.*
Reveal Formatting Pane

This pane is useful for examining the characteristics that have been applied to a piece of text. This includes fonts, styles, language settings, bullet and numbering styles and so on. To open the Reveal Formatting Pane:

1. Have the Styles Pane open (see above).
2. Select the Style Inspector button at the bottom of the Styles Pane. The Style Inspector pops up.
3. Select the Reveal Formatting button at the bottom of the Style Inspector. The Reveal Formatting Pane opens.

Note: Make sure that ‘Distinguish style source’ is checked at the bottom of the Reveal Formatting Pane.
Showing formatting characters and marks on the document

There are a number of non-printing 'characters' and marks that MS Word uses. While these do not show up on the printed page, it can be useful to make them visible while editing a document. The non-printing formatting marks include:

- Spaces,
- Tab characters,
- Paragraph ('carriage return') characters,
- Object anchors.

To show and hide the non-printing formatting marks on screen: **Ribbon… Home Tab… Paragraph Group > Show/Hide Button.**

*Note:* It is advised that Tab characters be avoided where possible for formatting. For example, to make a paragraph start off with an indent, it is better to set up a paragraph style that has an indented first line than it is to insert a Tab character at the start of each paragraph. In this way, text can be more easily managed in the editing process.
Avoid automatic formatting

Turning off 'AutoCorrect' functions

By default, MS Word tries to 'AutoCorrect' your typing. For example, if you start typing numbers in front of items, the MS Word software 'assumes' you are typing a list of numbers, and so changes the formatting automatically to a numbered list, with accompanying indentation, tab stops, tab characters and so forth.

While this may be a useful feature for novice users of MS Word, it is much better to manage styles yourself, applying your desired settings for indents, tab stops etc.

Furthermore, when you are trying to manage a document and apply the styles that are necessary to provide accessibility, 'AutoCorrect' features are more like to automatically break your efforts.

Therefore, while learning to make documents accessible, it is highly recommended that you turn off all of the AutoCorrect functions in Word. This will mean that it is you who have sole control over how the text looks and behaves.
To turn off AutoCorrect features:

1. Go to the **Word Options** dialog box. (*Ribbon... Office Button > Word Options*)
2. Go to **Proofing** and select the **AutoCorrect Options button**.
3. Uncheck every item in every tab of the dialog box.
1.1. Formatting

1.1.1. Use Styles for formatting

A) Rationale

A style is a set of formatting characteristics applied to paragraphs, tables, characters, or lists. In a document, styles are used to quickly and consistently change the appearance of the content. Styles can also impose a relational structure (hierarchy) on a document by assigning outline levels to headings.

Using styles means that information about the organization and hierarchy of the document's content is available to Screen Readers. This information can be used to navigate to the structural elements. It also allows screen reader user to skim through a document (reading only the headings, for example).

B) Development Methods

- Always use styles to format paragraphs, headings, table text, and lists (bullets and numbered lists).
- Where necessary, use styles to format characters (e.g., words that always appear in bold or italic).

1. Start in the Styles Group (Ribbon... Home Tab... Styles Group):
   a. To modify any previewed style, right click it.
   b. To preview more styles, select the drop-down icon.
   c. Open the Styles Pane for managing and controlling all available styles. To open the Styles Pane, select the icon in the bottom right corner of the styles group (shortcut is \texttt{CTRL\textasciitilde ALT\textasciitilde SHIFT\textasciitilde S})
2. Use the **Styles Pane** for managing and controlling multiple styles.
   a. To apply a style, select text in the main document and select a style name;
   b. To modify an existing style, right click the style name and then select the drop-down icon;
   c. To make new styles, and inspect and manage existing styles, use the controls in the bottom left corner of the Styles Pane;
   d. To set your preferences for how styles are displayed in this window, select the **Options...** button.
3. To make a new style or modify an existing style, right click on it in the **Styles Group** or in the **Styles Pane**. The **Style Dialog Box** appears. For each style:
   a. Give the style a name
   b. Select the type of style (Paragraph, Table text, Character or Link)
   c. A hierarchy structure of styles enables you to have changes in one style affect another. To make this style a 'child' of 'parent' style in the hierarchy, name the style that it is based on.
   d. For simple formatting (font name and size, color, paragraph alignment etc.), use the controls in this dialog box.
   e. For more detailed formatting of fonts, paragraphs, tabs, borders, language and numbering, use the **Format** drop-down menu.
      *Note:* 'frame' formatting should be avoided in this menu.
   f. To manage how the style is stored (e.g., just in the document or in the global template), use the various controls at the bottom of the dialog box.

*Note:* You should always make sure that the 'Automatically Update' checkbox is unchecked in the Style Dialog Box. Automatic updating of styles makes them very difficult to manage (see also 1.0 Preparation).
C) Testing Methods

There are various methods for inspecting a document to determine whether styles have been used. These methods can be used separately or together:

*Examine the Document Map:*

- View the **Document Map** (Ribbon... View Tab... Show/Hide Group... Document Map).
- **TEST:** Does the heading structure and hierarchy in the Document Map match the structure shown visually in the main document? *If it does not match, then the document is NOT properly formatted with styles.*

*Make the formatting marks visible in the document:*

- View the formatting marks in the document. (Ribbon... Home Tab... Paragraph Group... Show/Hide (¶) button).
- **TEST:** If there are TAB (→) characters used to provide indentation; if there are multiple Paragraph 'Return' (¶) characters used to provide spacing between paragraphs; if there are multiple SPACE (…) characters used to align text, *Then the document is NOT properly formatted with styles.*
View the **Style pane in the Draft View:**

- Set up a **Style pane.** ([Word Options > Advanced > Display... Style area pane width](#)). Set the width at 2 inches;
- Go to **Draft View.** ([Ribbon... View Tab... Document Views Group... Draft](#));
- **TEST:** If the same style name is always applied to every paragraph, even though the document has a look that has different types of paragraph and heading styles, *then the document is NOT properly formatted with styles.*

![Style Area Pane](image)

This is the Style Area Pane. It shows that all text has the same style name (this is bad)
Use the **Style inspector** and **Reveal formatting pane** to see what formatting has been applied to each paragraph:

1. Open the **Style Pane** and select on the **Inspect Styles button**.
2. In the **Inspect Styles Window**, select on the **Reveal Formatting button**.
3. In the **Reveal Formatting Pane**, examine the paragraph formatting.
4. **TEST**: If things like heading (outline) levels, style names and alignment settings are not applied, then the document is NOT properly formatted with styles.

---

**Example Image:**

1. At the bottom of the Styles Window, click ‘Inspect Styles’
2. In the Inspect Styles Window, click ‘Reveal Formatting’
3. In the Reveal Formatting Window, look at the formatting for each paragraph. Is the indentation and alignment set? Is there an outline level set for each heading?
1.1.2. Format paragraph line spacing with styles

A) Rationale

When paragraphs are formatted with styles, it is (a) easier for screen reader users to navigate, and (b) they have less keys to press. When paragraph line spacing is done incorrectly with multiple 'carriage return' (¶) characters, screen readers hear "Blank... Blank... Blank..." for each line.

Using style formatting for paragraph spacing also makes it easier to move blocks of text around during the document editing process. Using this method, spacing is automatically maintained, so there is no need to go back over the document and manually add 'carriage return' characters for spacing.

B) Development Methods

**Set paragraph spacing**

1. Open the Paragraph Dialog Box (Ribbon... Home Tab... Styles Group > Right Click style > Modify> Format > Paragraph)
2. Set the amount of points that should be before and after the current paragraph. For example, if the font is 12 points high, add 12 points of spacing after to get the effect of a blank line between paragraphs.

![Spacing Dialog Box](image)

C) Testing Methods

Use the same testing methods for *Use Styles for formatting (1.1.1)*.
1.1.3. Use list formatting

A) Rationale

When bulleted list and numbered list formatting is used, Screen Readers will properly announce the text as being part of a list, and provide a means for the user to quickly navigate between items as well as move in and out of lists.

When bullets and numbers are made with incorrect formatting, Screen Readers will treat the lists as regular text, meaning that the list reading controls are inoperative.

B) Development Methods

There are two main ways to set lists in MS Word:

1. **Define the list format in the style**: In the **Style dialog box**, Select **Format > Numbering** and then in the **Numbering and Bullets dialog box** set the type of list you want.

2. **Use direct paragraph formatting for lists**: Go to **Ribbon... Home Tab... Paragraph Group** and use the list controls.
Note: Even with automatic formatting turned off in MS Word (see 1.0 Preparation), some automation effects may persist in the lists, especially if the direct formatting is used. It may be necessary to right click on the list number (or bullet) and use the controls on the pop-up menu to set the numbering values correctly:

C) Testing Methods

Use the Reveal Formatting Pane (see 1.0 Preparation) to examine text to see if the text is defined as being part of a bullet list or number list.
1.1.4. Use Column formatting

A) Rationale

When column formatting is used, screen readers will read in the correct order (i.e., first go down one column and then move to the top of the next column).

When column formatting is not used (e.g., TAB characters are used to visually separate text to make it appear like columns), the reading order is garbled for screen reader users (the screen reader reads [row 1, column 1; row 1, column 2; row 2, column 1; row 2, column 2 etc.]).

B) Development Methods

Format the columns

1. Go to the Print Layout View: (Ribbon... View Tab... Document Views... Print Layout)
2. Open the Columns dialog box (Ribbon... Page Layout Tab... Page Setup Group > Columns > More Columns)
3. Set the number of columns, spacing between columns, and whether this formatting should apply to a section or the whole document.

To end one column and begin the next, use column breaks

If, for example, the text in one column is short and does not fill the whole length of the column, then add a column break to start a new column (rather than 'carriage return' [¶] paragraph marks).
C) Testing Methods

Use the same testing methods for *Use Styles for formatting (1.1.1)*.

You can also do a quick manual test in **Print Layout View**: *(Ribbon... View Tab... Document Views... Print Layout)*:

- TEST: Place your cursor anywhere in the column. Press the **right arrow** key and watch the cursor movement. The cursor should follow the text column by column.
1.1.5. Do Not Use Hyphenation

A) Rationale

Screen readers split up hyphenated words instead of speaking them properly as single words. Hyphenation can make reading very confusing for Screen Reader users.

B) Development Methods

Avoid using manual hyphenation techniques

Do not insert hard hyphens (using the dash/hyphen key) and/or line breaks to force end-of-line hyphenation.

- Delete instances of hard hyphens.

Remove automatic hyphenation

1. Open the Page Setup Group. (Ribbon... Page Layout... Page Setup Group).
2. Select the drop-down menu under Hyphenation and ensure that 'None' is the setting.

C) Testing Methods

1. Use the same method as in Development Methods (above) to check the Automatic Hyphenation setting.
2. Go through the document manually to find instances of manual hyphenation.
1.1.6. Do Not Use Drop Caps

A) Rationale

Although a drop cap letter is visually connected to the text that follows it, Word stores the drop cap letter separately to the text. Consequently, the Screen Reader software splits up drop capped words instead of speaking them properly as single words. Drop caps can make reading very confusing for Screen Reader users.

Word renders the drop cap as a special type of frame. In the example below, the word 'Guiding' has a dropped 'G' and so is spoken by the Screen Reader as "Gee. Uiding...".

Note: While it is not possible for drop caps to read properly with MS Word, it is possible to tweak PDF documents so that Screen Readers read drop caps properly. This involves some complex editing of PDF tags, that is beyond the scope of this guide.
B) Development Methods

Remove drop caps

1. Select the drop cap. A set of place markers will appear.
2. Press Delete to remove the frame containing the drop cap.
3. Add in the missing letter at the start of the sentence.

C) Testing Methods

• Go through the document manually to find instances of drop caps.
• Delete and replace drop caps as necessary.

1.1.7. Convert text boxes to regular paragraphs

A) Rationale

Text-boxes provide a means to add text to a document, and locate it anywhere on the page. Unfortunately, text boxes work more like images than text. Because of this, text boxes only show up in the 'print layout' view, and Screen Reading software is unable to access the information in a text box.

Instead of using text boxes, style formatting (1.1.1) can be used to locate the text in the desired place on the page. Style (paragraph-level) formatting may take a few more steps to achieve than using text-boxes, but style formatting is much more accessible for Screen Readers.

B) Development Methods

Development

During development, do not use the text box tool (Ribbon... Insert Tab... Shapes > Text Box); Instead, Use Styles for formatting (1.1.1).
Remediation

If text boxes have been used in a document (see Testing Methods, below):

1. **Copy** the text in the text box,
2. **Delete** the text box
3. **Paste** the text into the main document
4. Format the pasted text using Style formatting (**1.1.1**)
C) Testing Methods
There are two ways to check if text boxes have been used:

1. View the document in Page Layout view and in Draft View (Ribbon... View Tab... Document View).
   Note: To do this you can either:
   a. switch between the views; or
   b. open two versions of the same document and use a different view in each; or
   c. print the document and then compare it to on-screen Draft view.
2. In Page Layout View (Ribbons... View Tab... Document View > Page Layout), right click on any text that might be a text box. If placeholder marks appear and the text can be dragged and repositioned, it is a text box.
1.2. **Navigation**

1.2.1. **Place document titles in the main document; not the 'Header' area**

A) **Rationale**

A Word Document page is normally divided into three areas: 1) The Header area; 2) the Main Document area; and 3) The Footer area. Screen readers normally read only what is in the middle—the Main Document Area.

While it may seem logical to place a 'document heading' in the 'Header' area, this is not what the header area is intended for. The Header Area is the place to put running headers like a book or report name, author names and so forth. Similarly, the Footer area is for things like page numbers,
copyright messages and the like. Important information that should be read by Screen Readers, like document titles and page headings, as well as signatures at the end of memos, all need to be placed in the Main Document Area.

Note: while Screen Reader users are able to access the text in the Header Area and Footer Area, this is not a normal method of reading (it is awkward and difficult for Screen Reader users to keep track of text in these areas).

B) Development Methods

Move all text that needs to be read into the Main Document Area

1. Open the Header or the Footer Areas (Ribbon... Insert Tab... Header & Footer group > Header > Edit Header).
2. Cut information that has been erroneously placed in the Header or Footer.
3. Close the Header and Footer.
4. Paste the information into the Main Document Area.
C) Testing Methods

Use the same method as in Development Methods (above) to check content in the Header and Footer Areas.

You can also do a quick manual test in Print Layout View: (Ribbon... View Tab... Document Views... Print Layout):

- TEST: Place your cursor anywhere at the top of the document (Press \texttt{CTRL} + Page Up). The cursor should be at the top of the content that needs to be read by the Screen Reader (i.e., the natural starting point for the document).

1.2.2. Use Heading Levels in style formatting

A) Rationale

Headings are used to divide documents up into meaningful chunks of information. When headings are defined using Word's built-in heading styles, Screen Reader users can quickly navigate through the document. They can jump to the next heading, or to the next heading at a certain level (e.g., moving forward and backwards through the document at only the top level headings).

When headings are incorrectly marked up, using character formatting only (e.g., applying \texttt{BOLD} format, and/or using \texttt{ALL CAPITAL LETTERS}), there is no programmatic way for the Screen Reader to know where the headings are. Therefore, they (a) cannot easily navigate through a document, and (b) when a heading is reached there is no notification that what is being said is in fact a heading.

\textit{Tip}: Using the built-in styles for word means that the Heading styles can be easily used to build a linked Table of Contents (1.2.3) for the document, which also aids navigation.

B) Development Methods

Use the built-in Heading styles

\textit{Note}: See Use Styles for formatting (1.1.1) for an introduction to working with styles.

1. Open the \texttt{Styles Window}. (shortcut is \texttt{CTRL}+\texttt{ALT}+\texttt{SHIFT}+\texttt{S}).
2. If Headings 1 through 9 are not shown, select the Options... button at the bottom of the \texttt{Styles Window}, and make sure that 'All Styles' are visible in the list.
3. Apply the headings to the text in the main document.
4. If you need to modify the heading styles, right click the style name.

*TIP:* By default, heading 9 is based on heading 8, heading 8 is based on heading 7, and so on all the way up to heading 1. This means that if you start with the formatting for heading 1, all the changes will affect the lower headings. This is a useful way to manage the appearance and behavior of all the headings in the document.
**Ensure that Outline Level for a heading matches the visual appearance of headings**

If you are working on a document that did not use the built in Heading styles, and used custom style names for headings, it will be necessary to set the 'Outline Level' of each custom heading style.

1. Open the **Styles Window**. (shortcut is **CTRL+ALT+SHIFT+S**).
2. Right click the custom heading style.
3. In the style dialog box, go to **Format > Paragraph > Indents and Spacing TAB**.
4. Set the Outline level to match the visual appearance of the document headings. (e.g., the main title should be Outline Level 1, the next level down is Level 2, etc.).

C) Testing Methods

Use the same methods used **Development Methods** (above) to check the Outline Level of each style.

1.2.3. Use automation if creating a Table of Contents

A) Rationale

A Table of Contents (TOC) is a quick and effective means to examine the content of a document. A linked TOC is an even more effective means to examine and navigate a document. Providing a linked TOC therefore aids Screen Reader users to both understand the structure of a documents, and to navigate within it.
B) Development Methods

Create a linked Table of Contents

1. Place the cursor where you want the TOC to appear in the document.
2. Open the TOC dialog box (Ribbon... References Tab... Table of Contents Group > Table of Contents > Insert Table of Contents...).
3. Make sure 'Use Hyperlinks instead of page numbers' is checked.
4. Select the various desired options for the TOC
   a. Add page numbers, Tab Leaders etc.
   b. Use the Options... button to select the paragraph styles that will be used to form the TOC (the default includes all of the 'Heading' styles).
   c. If you need to modify how the TOC appears on the page, use the Modify... button.
Note: Once a TOC is introduced to the documents, styles named TOC 1, TOC 2, etc. should appear in the **Styles Window**. These TOC styles can be modified just like any other.

Note: Make sure you update the TOC when you complete editing the document.

C) Testing Methods

If the Table of Contents has been made properly using hyperlinks, it will be selectable. Make sure that the links in the TOC take you to the right destination heading. Also make sure that the TOC has been updated properly (i.e., the page numbers in the TOC match those in the Main Document).
1.3. **Language**

1.3.1. Set the language properties

**A) Rationale**

A Screen Reader converts text to speech, and it pronounces things according to the language specified in the style format settings.

Problems occur when the language has not been set at all, or it has been set to the wrong language. For example, if text is in Spanish but it has been set in the style format as English, then the Screen Reader software will speak the words as they are written, but with an English accent. To a Spanish speaking blind screen reader user, the speech will sound comical at best, and incomprehensible at worst.

**B) Development Methods**

Language can be set for the entire document, or, if there are multiple languages used in the document, language can be set at the character or paragraph level with styles.

*Note:* See *Use Styles for formatting (1.1.1)* for an introduction to working with styles.

**Set the language for the document if only one language is used**

1. Select all of the text in the document (CTRL+A).
2. Open the Set Language dialog box (Ribbon... Review Tab... Proofing Group > Set Language).
3. If the document is in English or Spanish then set the language to either
   a. English (U.S.)
   b. Spanish (International sort)

**Set the language for the individual styles if multiple languages are used**

*Note:* this requirement applies even if the documents contains only a few words or phrases in a different language.

1. Open the *Styles Window*. (shortcut is CTRL+ALT+SHIFT+S).
2. Right click on each style used in the document and Modify it.
   a. In the 'Style Properties' dialog box, select Format > Language... and set the language for this style.

*Tip:* if you have made styles with a hierarchical structure, you may only need to fix one or two styles instead of each style in the documents. For example, set the Normal style to 'English (U.S.)' and then every style...
based on he Normal style will be set properly. Then set up a style called 'Spanish text' and set the properties for this style. This strategy only works well if there is a hierarchy used to create the styles used in the documents.

C) Testing Methods
You can use the same methods for *Use Styles for formatting (1.1.1).*

- Check that the language setting is correct in the **Reveal Formatting** Window.
1.4. Fonts

1.4.1. Use System Fonts

A) Rationale

An easy to read font can make reading possible for people who have low vision, and much more enjoyable for people who have regular vision. While it may be tempting to be creative in your font choices, employing a 'fancy' or non-standard font can add frustration for many readers.

Poor choices are things like comic fonts and script/cursive fonts.

<table>
<thead>
<tr>
<th>Standard/System fonts (okay to use)</th>
<th>Non-standard fonts (to be avoided)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
<td>Comic Sans</td>
</tr>
<tr>
<td>Courier</td>
<td>Bernard</td>
</tr>
<tr>
<td>Verdana</td>
<td>Copperplate</td>
</tr>
<tr>
<td>Times New Roman</td>
<td>Script</td>
</tr>
</tbody>
</table>

Non-standard system fonts can include non-standard characters. For example, the 'symbol' and 'Windings' font sets contain iconographic characters that are not going to be read by Screen Reader software. If non-standard characters are used, an alternative description of the meaning of those characters is required for Screen Reader Users.

In addition, if you choose a font that is non-standard, there is no guarantee that the user of the document will have that font loaded on their computer. Their system will then do a font substitution, but this can negatively impact the layout and overall appearance/readability of the document.
Improving readability for people with low vision (Tiresias)

All of the graphic images showing menu commands in this guide have callouts that are in a font called 'Tiresias'. The Tiresias family of fonts have been designed to be highly readable by people with low vision.

Each character in Tiresias is visually distinct. In the example below, the word 'Illuminating' is shown in Arial and Tiresias for comparison. In the Arial font, a capital letter 'I' and a lower case letter 'l' can be confused because they look identical. The letter 'l's are more tightly spaced in the Arial font; wider spacing can aid readability for people with low vision.

![Arial font: Illuminating. Tiresias Font: Illuminating.](image)

The Tiresias fonts benefit people with visual disabilities, and they also benefit people with good vision by making information easier to read.

Note: Tiresias is a non-standard font at the present time. It has to be manually downloaded on each computer, since it does not come as part of any operating system. It is therefore generally not recommended at this time that Tiresias be used in documents that are intended to be delivered electronically to wide audiences. Tiresias fonts are very useful, however, for making easily readable presentation slides (so long as the font is loaded on the presentation computer) and printed signs.

The Tiresias fonts were developed by researchers at the Royal National Institute of Blind People in the United Kingdom.

Tiresias fonts are free to download from http://www.tiresias.org/fonts/
B) Development Methods

Use standard/system fonts in your document. Good choices are fonts like

- Arial
- Courier
- Times New Roman
- Verdana

A note on font size

One of the reasons for using standard/system fonts is that they scale well when enlarged/magnified on a screen. Because they scale, and because in this guide we are primarily interested in documents shown on screen (see Introduction), font size is not a critical issue. However, for general reading by the people who do not have vision impairments, the following font size guidance for print and screen-based information is offered:

- Minimum for readability: 9 point
- Normal for good readability: 11-12 point
- Large print: 14-18 point

C) Testing Methods

You can use the same methods for Use Styles for formatting (1.1.1).

- Check that the font is appropriate in the Reveal Formatting Window.
- Manually check that non-standard characters have not been used.
1.5. Graphics / images

1.5.1. Add Alternate Text to graphics / images

A) Rationale

Screen Reader software converts text to speech, but it cannot convert graphics/images to text. To overcome this, text can be programmatically attached to a graphic. The Screen Reader software then reads this "Alternate text" when a graphic is shown.

The amount and type of description that is put into the alternate text (commonly abbreviated to "Alt-Text") depends on the type/purpose of the graphic. There are three main types of graphic:

**Information-Type Graphics**

Information-Type graphics convey important information not contained in the adjacent text:

- Alternate text should succinctly convey in words the same information that is communicated by the graphic. It should represent the meaning, function, or purpose of the image, not just describe its appearance.
- **Information-Type graphics definitely need Alt-Text.**
**Redundant-Type Graphics**

*Redundant-Type Graphics* contain information that is repeated / duplicated in adjacent text or added as a caption associated with the image:

- *Redundant-Type Graphics require a judgment* to be made about what is the appropriate Alt-Text to provide. It may be okay to not provide any Alt-Text in this case, or it may warrant some short Alt-Text, for example "This graphic shows the dialog box controls as described in the main text".

  *Note:* Most of the graphics in this guide are of the *Redundant-Type*, with this short Alt-Text applied: "Graphic illustrating the information and/or steps in the surrounding text".

**Decorative-Type Graphics**

*Decorative-Type Graphics* contain no information necessary for the comprehension of the document's content:

- *Decorative-Type Graphics definitely do not need Alt-Text.*
B) Development Methods

1. Determine the type of graphic/image in order to prepare the appropriate Alt-text wording (see Rationale, above).
2. Right click the graphic and select **Format Picture**. Open the **Alt Text Tab** and type in the appropriate Alt-text.
Note: If you are working on a new (unsaved) document, there might not be an Alt-text Tab when you try to format the picture. This is a result of Word 2007 using a new XML-based formatting system. If this is the case, do the following procedure:

1. Save the document. This should convert the document to the older Word 2003 (non-XML) format. The document extension should be ".doc"; not ".docx"
2. Re-open the document. It should now be in the older format and the above procedure should now work.

Note: if you are working on a document that needs to be saved in the Word 2007 (XML) format, then the following procedure will need to be followed for adding Alt-text to graphics:

1. Select the graphic. A Picture Tools menu appears at the top of the Ribbon.
2. Select the Picture Tools menu.
3. Select the small icon in the bottom right corner of the Size group. This brings up the Format Picture dialog which will have an Alt-Text Tab.

C) Testing Methods

1. Determine the type of graphic (Information-Type, Redundant-Type, or Decorative-Type). See Rationale, above for an explanation of graphic types.
2. Use the same method as in Development Methods, above to check that the Alt-text is appropriate for the type of graphic.
1.5.2. Group Complex Objects

A) Rationale

If you use the drawing tools in Word that are found in **Ribbon... Insert Tab... Illustrations Group** (e.g., Clip Art, Shapes, Smart Art, Charts), then each object that you use to create a larger visual picture is treated as a separate object in Word. The problem for Screen Readers is that there is no logical place to add the Alt-text necessary to convey the meaning of the larger visual picture.

The solution for this problem is to group the objects into one picture, and then **Add Alternate Text to graphics / images (1.5.1)** to the group.

*Note:* If a graphic/image is imported into a Word document from another program, it will normally be a single object within Word. Alt-text can then easily be applied to the single object.
B) Development Methods

1. Select the objects that are to be grouped:
   a. Corral the objects by clicking and dragging a box around the objects; or
   b. Hold down the [CTRL] key continuously while you left click on each object to be grouped.

2. Group the objects:
   a. Right click on one of the objects and select Grouping > Group; or
   b. Go to Ribbon... Picture Tools Tab... Arrange group > Group.

3. When the object is grouped, be sure to then add the appropriate Alternate Text (1.5.1).
C) Testing Methods

1. Select on the graphics/images in the document. They should have only one set of markers applied to them (see Development Methods, above).

1.5.3. Place graphics / images 'in line'

A) Rationale

Graphics/images can be 'placed' in a Word document as 'in line' with the text, or they can be placed as 'floating' and 'anchored' near the text. Screen Reader software can only detect and properly read the Alt-text (1.5.1) associated with a graphics when it is placed 'in line'.

B) Development Methods

1. Right click the image and select Format Picture.
2. In the Format Picture dialog box, select the Layout Tab, and select 'Inline with text'.
3. The graphic may appear to move in the document from where it is intended to be placed. If necessary, move the graphic to the correct location.

*Note:* Inline graphics can be treated like regular text, in that they can be placed on the left, right, or centered on the page. To make editing easier, a style can be created to help manage how graphics are laid out throughout the document—see *Use Styles for formatting (1.1.1)*.

1. Right click the graphic, then select **Format Picture**

2. Make the wrapping style 'In line with text' in the 'Layout' Tab.
C) Testing Methods

Check that the image is inline:

1. Make formatting marks visible with the **Show/Hide** (¶) button (Ribbon... Home Tab... Paragraph Group> Show/Hide button);
2. Make sure the anchor symbol (✂) DOES NOT APPEAR next to any graphic/image. (If the images are properly inline there will be no anchor symbols).

1.5.4. Avoid (or carefully control) text rendered as images

A) Rationale

*Word Art*

Word Art is a tool in MS Word for rendering text as an image. Any text can be converted to a stylized image using the tool in (Ribbon... Insert Tab... Text Group > WordArt).

When Word Art is created, Alternate text is automatically created, and MS Word treats the text as an image. So long as the relevant best practices for graphics/images are followed (1.5.1, 1.5.2, 1.5.3), any piece of Word Art should be readable with a Screen Reader. However, the choice of Word Art styles can greatly impact the readability of the text for people with low vision.
Word Art offers a number of possible things you can do to enhance text, but some of these things actually reduce readability for people with low vision. They include, but are not limited to:

- Low contrast with the background (see 1.8.1) or that do not work well with reverse color schemes (see 1.8.2);
- Slanting text (i.e., not on the horizontal);
- Shadow effects that overlap the text and/or lower the contrast of the main text;
- Character spacing that is too tight or too wide.

HARD TO READ WITH LOW VISION: Slanting, non-uniform text; overlapping shadows...

... or shadows that are low contrast compared to the text; tight font spacing; and off-horizontal layout...

... or angled text; textured surfaces; and dark shadows for 3-D effects.

BETTER FOR LOW VISION: Higher contrast with background; Wider spacing between characters; uniform direction and layout.
**Text as a component of a graphic/image**

If text is rendered on top of / as a part of a larger image (either as Word Art or as plain text), then the relevant best practices for graphics/images should be followed (*Alternate text*, 1.5.1; *Grouping of complex objects*, 1.5.2; and *Placing graphics inline* 1.5.3).

**Watermarks**

Watermarks are used to 'stamp' each page of a document. Common examples are 'Confidential' and 'Draft'. The Watermark is placed in the background. There are a number of accessibility issues raised by Watermarks:

- The Watermark is normally centered on the page behind the text. It is actually stored in the document as a part of the Header and Footer areas, and this area is not normally read by Screen Reader software (*see* 1.2.1);
  
  *Note*: Because the Watermark is a special variant of Word Art (see above), Alternate text (*see* 1.5.1) is automatically generated for the Watermark. However, the Screen Reader user would have to know of the Watermark’s existence before going to look for this Alternate text—which is something they cannot determine without prior knowledge;
• If using a watermark color that does not sufficiently contrast with the text in front of it, it may be more difficult to read by people who have low vision (see contrast, 1.8.1); and
• Watermarks will tend to 'wash out' (be impossible to see) in reverse color schemes used by some people who have low vision (see 1.8.2).

**Animated text**

There is no section in this guide for animated text, as the animated text feature has been removed from MS Word 2007 onwards.

**Note:** In general for document creation, animation of text should be avoided because the animation effects are not detected by Screen Readers, and the effects can impair the readability of documents by people with low vision.

**B) Development Methods**

**Word Art**

• Where possible, avoid using Word Art (i.e., change Word Art to real text).
• If Word Art is unavoidable, try to render the text so that it is more readable for people with low vision (see list above under Rationale).

**Text as a component of a graphic/image**

• Where possible, avoid placing text over the top of images.
• If this is unavoidable, try to render the text so that it is more readable for people with low vision (see information above under Rationale).

**Watermarks**

• If a watermark is essential, add the watermark text at the beginning or close to the beginning of the document. For example: "Document Status: Draft".
• Use Watermark colors that contrast with the text. For example, if the text is black, use very light gray for the watermark. Also consider using outlined letters in very light gray, rather than filled-in letters (see contrast, 1.8.1).

**Animated text**

See Rationale, above.
C) Testing Methods

- Visually inspect Word Art and text as components of images.
- Ensure that best practices for Graphics/images (1.5) and Color (1.8) are followed.
1.6. Tables

1.6.1. Remove table formatting applied to non-tabular information

A) Rationale

It is possible to use tables as a means of applying a desired visual layout. For example, text that is supposed to show in four columns can be placed in a table with one row and four columns. Visually, there are four columns of text. This is problematic for Screen Reader users. Tables are meant to be used for tabular information (data).

Screen Reader users can easily navigate to and examine data in tables. There are specific keyboard controls for reading tables that differ to the controls for reading regular text. When non-tabular text is rendered with tables, the reading controls are incorrect. This can make it confusing and difficult to read the document with a Screen Reader.

B) Development Methods

For any non-tabular text, visual formatting can be achieved without the use of tables. For guidance, see 1.1.1 Use Styles for formatting, and 1.1.3 Use list formatting.

C) Testing Methods

There are two ways to determine whether tables have been used for visual formatting of non-tabular information:

1. Right click on any text that you suspect is formatted as a table. If the Table Tools part of the Ribbon shows up, table formatting has been used.
2. Make table gridlines visible for all tables in the document: (Ribbon... Home Tab... Paragraph Group > Borders > View Gridlines). If gridlines show up around non-tabular information, tables have been used.

1.6.2. Set the header row as 'repeating'

A) Rationale

It is possible to programmatically assign a table row as being the 'header row'. This enables the Screen Reader software to be able to tell the user for each cell what the header for that column is.

Without the header row being properly identified, the Screen Reader can only say (using the example in the image below) 'Column 3' instead of 'Column 3, dessert'. This is not as great an issue in a simple table of only a few rows and columns, but in a data table of 20 rows and 15 columns, being able to identify the heading is extremely useful.
B) Development Methods

1. Place the cursor anywhere in the first row of the table. Right click and select Table Properties from the pop-up menu.
2. Select the Row Tab in the Table Properties Dialog Box.
3. Check ‘Repeat as header row at the top of each page’
   Note: Do this even if the table does not go over multiple pages.

C) Testing Methods

Use the same methods as Development methods (above) to check to see if the header row setting has been checked for the first row of each data table.
1.6.3. Remove text wrapping around tables

A) Rationale

Screen Readers software works well when it is reading across the page in either Table Reading Mode, or in Text Reading Mode.

When text is wrapped around a data table (so that it appears to wrap around the left or the right side of the table), there is an increased likelihood of reading errors. The Screen Reader Software may have a difficult time switching between Table Reading and Text Reading Modes, and deciding which thing to read first (the text or the table).

To remedy this problem, tables should be presented in their own lines of the page, without any wrapped text to the left or the right.
B) Development Methods

1. Place the cursor anywhere in the table. Right click and select **Table Properties** from the pop-up menu.
2. Select the **Table Tab** in the **Table Properties Dialog Box**.
3. Select **‘Text Wrapping None’**

   *Note:* After this is done, it may be necessary to move the text that was originally wrapped around the table (i.e., it might move to after the table, but logically it should be placed before the table).

C) Testing Methods

Visually inspect and or right click in any table as per *Development methods* (above) to see if text is wrapped around data tables.
1.7. **Links**

1.7.1. **Assign link names that make sense when spoken in isolation**

**A) Rationale**

When a Screen Reader is reading text and there is a link, the software will insert the word "Link" in front of the text to alert the user that this is a selectable hyperlink.

Another way that Screen Readers can access the links that are in a document is for them to call up a list of links. This list will display only the text that has been marked as a link.

It is important that the list of links makes sense to the user when it is read out of context. That is, the name of each link should make sense in the list when it is read in isolation.

Consider the following four examples of the same text and same link rendered using different methods:

1. Please read The SSA Online Accessibility Policy. [Click Here](http://www.ssa.gov/webcontent/accessibility.htm)
2. Please read The SSA Online Accessibility Policy. [http://www.ssa.gov/webcontent/accessibility.htm](http://www.ssa.gov/webcontent/accessibility.htm)
3. Please visit The SSA Online Accessibility Policy.
4. Please visit The SSA Online Accessibility Policy: [http://www.ssa.gov/webcontent/accessibility.htm](http://www.ssa.gov/webcontent/accessibility.htm)

If every link in the document was rendered using method #1, the list of links would read like this:

- Click Here
- Click Here
- Click Here
- Click Here

It is easy to see that individual links are not possible to read out of context.

If every link was rendered using method #2, the list would read like this:

- [http://www.ssa.gov/webcontent/accessibility.htm](http://www.ssa.gov/webcontent/accessibility.htm)
- [http://ssa.gov/pgm/links_disability.htm](http://ssa.gov/pgm/links_disability.htm)
- [http://www.section508.gov/](http://www.section508.gov/)

This list also makes no sense in context. While we might be comfortable in normal conversation saying "go to s s a dot gov" we generally do not say to people "go to s s a dot gov slash p g m slash links underscore disability dot h t m". It is too long and it is too difficult to understand. However, when
the list of links is presented this way, this is exactly how the Screen Reader will say each link.

If every link was rendered with method #3, the list would be read like this:

- The SSA Online Accessibility Policy
- SSA Disability Benefits
- GSA’s Section 508 website

Using this method, all of the links make sense when spoken out of context. This is the best method to use.

Where it is important to have the URL displayed on the printed page, Method #4 is the same as method #3, but with the URL also spoken in the list. This method is perfectly acceptable, so long as the name comes first and the URL comes last in each link.

B) Development Methods

1. Right click any hyperlink in the document.
2. Make sure that in the Hyperlink dialog box the 'Text to display' field has a link name that makes sense when spoken in isolation.

   Note: See Rationale, above for an explanation of how links are spoken by Screen Readers.

C) Testing Methods

Examine the document for instances of links that have names like 'Click Here', and/or links that are just URLs, like http://ssahost.ba.ssa.gov/arc/. These links need to be remediated according to Development Methods, above.

1.7.2. Where possible, do not allow links to span two lines of text

A) Rationale

When a document gets converted to a PDF, links that span two lines of text will be read by a Screen Reader as two links instead of one.

B) Development Methods

Where possible, format the text so that links so that they remain on one line of text.

C) Testing Methods

Open the document in Print Layout view (Ribbon… View Tab… Document Views… Print Layout). Examine the links to determine whether they span two lines, and fix as necessary.
1.8. **Color**

1.8.1. **Use text colors that contrast with their backgrounds**

A) **Rationale**

Color contrast in documents is the difference between the brightness of the text compared with its background.

In the table below, the background of the text is shown in increasing shades of gray. The shades of gray are numbered in Word's color picker as increasing percentages.

As the gray percentage *increases* the contrast *decreases*. Black text on a black background has a contrast of zero (as does white text on a white background).

<table>
<thead>
<tr>
<th>Shading</th>
<th>10%</th>
<th>20%</th>
<th>30%</th>
<th>40%</th>
<th>50%</th>
<th>60%</th>
<th>70%</th>
<th>80%</th>
<th>90%</th>
<th>100%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>text</td>
</tr>
<tr>
<td>Contrast</td>
<td>90%</td>
<td>80%</td>
<td>70%</td>
<td>60%</td>
<td>50%</td>
<td>40%</td>
<td>30%</td>
<td>20%</td>
<td>10%</td>
<td>0%</td>
</tr>
</tbody>
</table>

Zero contrast text is impossible to read by *everyone*. 10 per cent contrast text is readable by people who have very good eyesight. In general, as we age, our contrast sensitivity goes down. Also, some younger people can have low contrast sensitivity.

*While we may be able to read 10% contrast text ourselves, we must remember that not everyone can.*

Good contrast is not limited to shades of gray. It applies to every color. Certain color combinations provide *low levels* of contrast, as the examples in the table below show.

<table>
<thead>
<tr>
<th>Shading</th>
<th>blue</th>
<th>green</th>
<th>yellow</th>
<th>black</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>red</td>
<td>black</td>
<td>orange</td>
<td>brown</td>
</tr>
</tbody>
</table>

Certain color combinations provide *high levels* of contrast, as the examples in the table below show.

<table>
<thead>
<tr>
<th>Shading</th>
<th>blue</th>
<th>green</th>
<th>yellow</th>
<th>black</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>yellow</td>
<td>yellow</td>
<td>red</td>
<td>white</td>
</tr>
</tbody>
</table>
B) Development Methods
Choose combinations of foreground colors and background colors that provide good levels of contrast.

C) Testing Methods
Although it is difficult to replicate having low contrast sensitivity with your own eyes, there are several means to look at how well the text contrasts with its background:

- Print the text on a color printer and a black and white printer. Does it look as readable?
- Print the text and try reading it in a dimly lit room. Is it readable?
- Adjust the color and brightness settings on your monitor. Is the text still readable?

1.8.2. Use automatic color settings for black text and white text

A) Rationale
People with certain types of vision impairment prefer to use their computer in either High Contrast Mode, where the differences between the text and backgrounds are made greater; or in High Contrast Reverse Mode, in which the white backgrounds are changed to black, and black text is changed to white. These changes take place in the operating system, and can be set in the Control Panel:
In MS Word, text can be rendered as any color, or as 'Automatic'. When one of these high contrast modes is chosen by the user, the following will happen:

- Text that is assigned the color 'White' will not show up in High Contrast Mode.
- Text that is assigned the color 'Black' will not show up in High Contrast Reverse Mode.
- That that is assigned the color 'Automatic' will show up in either of the high contrast modes.

By using the 'Automatic' color setting for black and white text, the text will be visible for people who rely on these high contrast modes for accessing their computer.

For other colors, the automatic setting might not work as well, but so long as efforts are made to provide high contrast (see 1.8.1) the text should be readable by most readers with low vision.

**B) Development Methods**

When setting up styles for text that is intended to be shown as black or as white, set the font color to 'automatic'.

**C) Testing Methods**

Use the **Reveal Formatting Pane** to examine text to see if black text and white text is assigned color automatically (see 1.0 Preparation).

Using the high contrast settings in the accessibility control panel of your computer is also a good means to check to see how the document looks in high contrast modes.

**1.8.3. Provide redundancy for information presented in color**

**A) Rationale**

Some people have color vision problems where they cannot distinguish between certain colors, certain shades of the same color, or see any color at all.

Using color to emphasize or call attention to certain elements may help make documents easier to read for many people. However, when color is used as the only way to convey information, the meaning can be lost to those with color vision problems.
For example, if completed items in a table are indicated by a green X and incomplete items shown as a red X, they may appear identical to someone who is color blind (and they will sound the same to someone using a Screen Reader):

<table>
<thead>
<tr>
<th>Task</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1</td>
<td>January 3, 2010</td>
<td>X</td>
</tr>
<tr>
<td>Task 2</td>
<td>February 9, 2010</td>
<td>X</td>
</tr>
<tr>
<td>Task 3</td>
<td>March 4, 2010</td>
<td>X</td>
</tr>
</tbody>
</table>

To remedy this, provide another (redundant) means of giving the information (size, shape, or character, for example):

<table>
<thead>
<tr>
<th>Task</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1</td>
<td>January 3, 2010</td>
<td>Y</td>
</tr>
<tr>
<td>Task 2</td>
<td>February 9, 2010</td>
<td>N</td>
</tr>
<tr>
<td>Task 3</td>
<td>March 4, 2010</td>
<td>Y</td>
</tr>
</tbody>
</table>

B) Development Methods

Only use color as an enhancement, not as the sole means of conveying information.

C) Testing Methods

- Print the text on a black and white printer. Is the information still conveyed properly?
- Adjust the color settings on your monitor. Is the information still conveyed properly?
1.9. Document properties

1.9.1. Set the document title in document properties

A) Rationale

A document can have 'properties' assigned to it, such as a title, the name of the author, the name of the company that produced it. Some of these properties might initially be blank, or filled in automatically by MS Word. All of the properties can be manually set by the document author.

When a Screen Reader opens up a document, it will first try to say the title assigned in the properties. If that is blank, it will say the filename. For the same reason that links are better if they are spoken with real names rather than URLs (see 1.7.1), the properties are better if they are spoken as real names (e.g., "Application for Benefits") rather than file names (e.g., "appl_ben_version4.pdf").

Note: There are a number of other benefits to setting the document properties:

- Most search engines use the title of a document to describe the document in their search results list. If a file does not have a title, the file name appears in the results list instead;
- Setting other document properties, such as subject, category, and keywords, is also useful for returning high-quality search results; and
- Setting the author of the document is extremely helpful in tracking down the originator of the document. This may be necessary when it is time to update the document, or for dealing with document issues, such as security settings, certifications, and signatures.

B) Development Methods

Set the document title (and other desired properties):

1. Select the Office Button.
2. Select Prepare > Properties.
3. Set the properties in the pop-up fields.

Note: More document properties can be set in the Advanced Document Properties dialog box, which can be found in the information section at the top of the properties pop-up fields.
C) Testing Methods

Use the same methods as above in *Development Methods* to check that the title of the document in the properties is the same as the title in the main document.
2. Converting from Word to PDF

2.0. Essential concepts

Notes:

- Make sure you have version Acrobat Pro 8.1 and the CommonLook plug-in installed (See About this guide, Section 0.0).
- This guide does not include information of producing accessible PDF forms. See About this guide (0.0).

Easy ways and hard ways to make an accessible PDF

There are several methods for making a PDF document, including:

1. In MS Word with Adobe Acrobat Pro 8.1 installed, converting a Word document to PDF with the PDF Maker application;
2. In other Adobe applications (e.g., InDesign, LiveCycle), outputting a document as a PDF file;
3. In MS Word and other MS Office applications, saving a file as a PDF;
4. Scanning images of documents, and putting those page images in sequence into a PDF.

Method #1 in the above list is the easiest and most efficient method for most document authors to create an accessible PDF.

For document authors using method #2 (producing a PDF from other Adobe applications), some of the settings information in this guide for conversion may be helpful to know, but this guide is not intended to cover this method.

Although the standard application of MS Word is capable of saving a file as PDF (method #3), it is not recommended because this method does not properly format the PDF to work with Screen Readers and other technologies typically used by people with disabilities (PWDs). Using method #3, the following problems can occur:

- Graphics do not get identified properly;
- Headings do not work properly;
- Tables do not get formatted in a way that works well with Screen Reader table reading controls.
The final method, using scanned images (#4 in the above list), means that you are starting out with images of text rather than text that can be read by a Screen Reader. If you wanted to make this type of document accessible, you would first have to run Optical Character Recognition software (which can be unreliable depending on the quality of the images) to convert the images to readable text. Next you would have to replicate the structure (headings, lists, links etc.) in the converted text. This is a very difficult way to create an accessible PDF.

*This section of the guide therefore concerns method #1 in the above list, converting to PDF using the PDF Maker application.*
Conversion is one-way, with no going back

You can convert a Word Document to a PDF with the PDF Maker application; but there is no equivalent conversion process for turning a PDF back into a Word Document.

This means that if you start with a Word Document, convert it to PDF, and then start making changes to the PDF, those changes are not reflected in the Word Document. If you need to make any edits or fixes to the Word Document, you will need to convert it to a PDF again, losing any work you did on the earlier version of the PDF file. This is important to know, because the rule of thumb is that:

• The more you can do to make your Word Document accessible…
• The less work you will have to do to make your PDF version of the document accessible; and
• The less work you will have to do to convert documents if and when their contents get revised in at a future date.
If you start with a Word document that has poor accessibility, you are almost certain to have an inaccessible PDF document. If you have a Word document that has good accessibility, the conversion should go smoothly, and you are likely to have a mostly accessible PDF. There will still be some things to check, even if you start off with a Word document that has good accessibility.

Generally speaking, the more you can do to fix accessibility issues in the Word Document, the better your conversion will be. See the section of this guide on Producing Accessible Word Documents (Section 1).

What if I don't have the source file in Word format?

I have a PDF file with selectable text:

There are two main options if you have a PDF that needs to be made accessible, but you do not have an original Word file to convert to PDF:

1. **Manually identify and fix all of the problems in the PDF:**
   This requires doing all of the steps in the next section of this guide *(Checking and fixing accessibility issues in PDF documents option, Section 3)*;

2. **Saving the text in the PDF in an MS Word file, and then reformatting it from scratch:** This option can be achieved by either:
   a. Going into the PDF and copying all of the text and then pasting it into a blank word document. Some of the formatting may be kept, but it may not be correctly formatted for accessibility;
   
   b. Using a third-party application to convert PDFs to other formats including Word. This option may produce some better formatting, depending on the quality of the application's conversion process, but it still may not be correctly formatted for accessibility;
c. Going into the PDF and copying all of the text and then pasting it as *unformatted text* into a blank word document *(Ribbon… Home Tab… Paste… Paste Special > Unformatted Text)*. None the formatting will be kept, but it may be easier to then apply the correct formatting in Word. *Note:* Page numbers and running headers that show on the PDF will probably be picked up in the copied and pasted text, and will need to be manually removed from the pasted text in the Word file.

*I have a PDF file that has non-selectable text (all pages are images):*

As stated earlier, this is a very difficult way to create an accessible PDF. The following steps are necessary:

1. Run Optical Character Recognition on the text. This feature is available in the Acrobat Pro application.
2. Check the quality of the conversion manually (depending on the quality of the source image, some characters, word, or even whole sections might be incorrectly recognized by the OCR software);
3. Go to the procedures listed above for *'I have a PDF file with selectable text'*.
2.1. Conversion from Word to PDF

**Notes:**

- *Make sure you have version 8.1 and the CommonLook plug-in installed (See About this guide, Section 0.0).*
- *Use the 'PDF Maker' application that gets installed in MS Word as a part of Acrobat Pro.*
  
  *Do not use the 'Save As PDF' feature in Word, because it does not make an accessible PDF (See Essential concepts, 2.0).*

2.1.1. Configure Conversion Preferences

**Note:** If you do not have the Acrobat Tab showing, you might not have Acrobat Pro set up correctly, or you might have version 8.0 of Acrobat Pro on your system. *Version 8.1 or higher is necessary.*

1. In MS Word, go to **Ribbon... Acrobat Tab... Create Adobe PDF Group** > **Preferences**.
2. **Settings Tab**—the following settings should be used:

- **Conversion Settings**: *Standard*
- **View Adobe PDF result**: *checked*
- **Prompt for Adobe PDF file name**: *checked*
- **Convert Document Information**: *checked*
- **Create PDF/A compliant file**: *unchecked*
- **Fully functional / Quick and simple PDF**: *Fully functional*
- **Attach source file to Adobe PDF**: *unchecked*
- **Add bookmarks to Adobe PDF**: *checked*
- **Add links to Adobe PDF**: *checked*
- **Enable accessible and reflow with Tagged PDF**: *checked*
- **Advanced settings**: *leave as default*
3. **Security Tab**—the following settings should be used:

- Require a password to open the document: **unchecked**
- Use a password to restrict printing and editing of the document and its security settings: **unchecked**

*Note:* If security settings have to be used, ensure that "Enable text access for screen reader devices for the visually impaired" is checked.
4. **Word Tab**—the following settings should be used:

- Convert displayed comments to notes in PDF: *unchecked*
- Convert cross-references and table of contents to links: *checked*
- Convert footnote and endnote links: *checked*
- Enable advanced tagging: *checked*
5. **Bookmarks Tab**—the following settings should be used:

- Convert Word Headings to Bookmarks: *checked*
  
  *Note:* it is possible, using the list in this dialog box, to set the levels of headings that you want to appear as bookmarks in the PDF.
- Convert Word Styles to Bookmarks: *unchecked*
- Convert Word Bookmarks: *unchecked*
2.1.2. Convert the document with the 'PDF Maker' application in Word

1. In MS Word, go to **Ribbon… Acrobat Tab… Create Adobe PDF Group > Create PDF**.
2. Make sure that the **Fully Functional PDF** radio button is selected.
3. Select the **Save button**.
3. Checking and fixing accessibility issues in PDF documents

Notes:

- Make sure you have version Acrobat Pro 8.1 and the CommonLook plug-in installed (See About this guide, Section 0.0).
- Before starting this guide, it is highly recommended that you be familiar with Section 0.1, Reading technologies, and implications for document design.

3.0. Preparation

The 'Accessibility Full Check'

The 'accessibility full check' is a tool within Acrobat Pro, used to provide an overview (but not necessarily a complete list) of accessibility problems that may need to be remediated (fixed). Although this check is not absolutely necessary to do, it does offer a useful place to start with any newly created PDF to get an overview of the type and number of problems.

Running the Accessibility Full Check

1. Have the PDF open in Acrobat Pro.
2. Choose Advanced > Accessibility > Full Check.
3. Configure the Accessibility Full Check dialog box:
   a. Create Accessibility Report: checked (You can choose a location for the report);
   b. Include repair hints in accessibility report: checked
   c. Create comments in document: do this only if you prefer to see the comments in the document itself.
   d. Page range: all
   e. Checking options (Name of Options): Adobe PDF
      Note: Section 508 is an option, but it is best to use the Adobe PDF setting;
      Note: With the CommonLook plug-in installed, it is also possible to check the document for compliance with Section 508 standards (a drop down list is seen in the middle of this dialog box).
   f. Check all checking options using the Select All button.

4. Select the Start Checking button.
5. A dialog opens reporting the problems found in the document.

![Image of Adobe Acrobat dialog]

The checker found problems which may prevent the document from being fully accessible.
+ This document is not tagged, the reading order of the contents may be incorrect.
+ 13 images(s) with no alternate text.
+ All of the text in this document lacks a language specification.
+ 109 words(s) that contain characters with no reliable mapping to Unicode.

6. Note the problems found and dismiss the dialog by selecting **OK**.

*Note:* If the report says that there are zero problems found in the document, remember that this is simply an indicator based on automated testing, a score of zero does not necessarily mean there are no accessibility problems with the document. A checklist should still be completed for each PDF (see the attachments to this guide).

7. A report opens in a side window with a list of problems and links to specific areas of the document. Comments and highlights within the document indicate potential problems.

![Image of Accessibility Report for test.pdf]

**Accessibility Report for test.pdf**

Use this report to identify accessibility errors. Click on the link for each error to highlight the location of the error in the PDF file.

**Report Contents**
- Detailed Report
- Summary
-Hints for Repair

**Detailed Report**

**Page Content Errors**

- 2 images(s) with no alternate text. ([How to Add Alternate Text])
  1. No alternate text
- 109 word(s) that contain characters with no reliable mapping to Unicode. ([How to Add Character Encoding])
  1. No Unicode for characters
  2. No Unicode for characters
  3. No Unicode for characters
  4. No Unicode for characters
8. To view and highlight problem individually, open the **Comments tab** (Comments > Show Comments List) and select individual comments within the Comments pane. The corresponding element in the document will be highlighted.  
*Note:* After addressing each problem noted by a comment, delete the comment (otherwise it will appear as an untagged element the next time the Full Check is run).

---

**Remediating accessibility problems found in the check**

It will be necessary to address the problems reported in the accessibility full check. Refer to the table of contents at the start of this guide and/or the checklist attachment at the end of this guide to locate the section(s) containing guidance on how to remediate the problems found.

*Note:* The ‘full check’ does not cover all of the elements in this guide that need to be checked. To be sure that all necessary checks are made, fill out a checklist (*see the attachments to this guide*) for each document being tested.
The Reflow view

The 'Reflow view' is a tool within Acrobat Pro that enables you to get a quick overview of how the PDF's visual structure compares to its logical structure contained in the tags. Although looking at the documents in this view is not a necessary step, it does offer a useful comparison for identifying possible problem areas. The Reflow view will more closely resemble the reading order employed by the Screen Reader software.

- To toggle the document Reflow view: **View… Zoom… Reflow View**.

*Note:* The 'Reflow view' should be used as an indicator only. To be sure that all necessary checks are made, fill out a checklist for each document being tested (*see the attachments to this guide*).

The Read Out Loud feature

The 'Read Out Loud' tool in Acrobat Pro is a very simple screen reading tool that can give you an idea of how the document will be spoken by a Screen Reader. This feature can be used in normal views or in the Reflow view (*see above*).

- To use the Read Out Loud controls: **View… Read Out Loud… Activate/Deactivate/Pause/Stop etc.**

*Note:* The 'Read Out Loud' feature should be used as an indicator only. It is not an accurate test of how or whether a Screen Reader user will be able to read the page. To be sure that all necessary checks are made, fill out a checklist for each document being tested (*see the attachments to this guide*).
Other guidance and Help

*Note:* The more you have formatted your original Word document with accessibility in mind (see *Producing Accessible Word Documents*, section 1), the less likely it is that you will need to consult the following additional sources of guidance and help.

**Help in Acrobat Pro for accessibility**

For some tasks requiring advanced editing of PDFs, there may be a need to consult the Acrobat Pro help ([Help… Complete Adobe Acrobat Professional Help… Accessibility, tags, and reflow](#)).

*Note:* The Acrobat Pro help window can take a very long time to load.

**CommonLook accessibility verification**

The CommonLook plug-in for Acrobat Pro includes a step-by-step verification process for checking the accessibility of PDFs. The Plug-in also has a tool for remediating tables. For more guidance, see the CommonLook manual.
Limited 'Undo' capabilities in Acrobat Pro during accessibility remediation

The is no 'undo' command available for many of the tools used to fix accessibility issues with Acrobat Pro.

For example, in setting the reading order (3.1.2) and modifying table tags (3.6.1), there is no way to go back if you make a mistake.

For this reason, it is highly recommended that you save your work (save the PDF file) every few minutes, and/or before making a substantial change to the document.
3.1. **Reading order**

3.1.1. **The initial view is set properly?**

A) Checking

The 'initial view' settings dictate how the document appears when it is opened by the end-user.

The initial view settings allow you to set:

- Whether the navigation tab should show up (it should show up as *Bookmarks Panel and Page* because the Bookmarks Panel is a useful means of navigation for Screen Reader users);
- Whether single or multiple pages should show (*single page* is preferred for Screen Reader and Screen Magnification users);
- The Magnification—either actual size, fitting to the width of the window, a certain percentage etc. (unless there is a strong reason to override the user's preferences, the *Default* setting is best for Screen Magnification users… as this setting brings up the document in the user's preferred size on the screen);
- The starting page (ordinarily this should be *page 1*).

To get to the initial settings, open **File… Properties** to bring up the **Document Properties dialog box**. Then select the **Initial View Tab**.
B) Remediating

2. Page Layout: 'single page';
3. Magnification: 'Default';
4. Open to Page: 'Page 1' (or Last viewed page if that is an option).

*Note:* when done, open the PDF in Adobe Reader to double check that the initial view is set properly.
3.1.2. The reading order is correct?

A) Checking

The reading order is the order in which the Screen Reader will speak the information presented on each page.

1. View the reading order for each page: **Advanced… Accessibility… Touch up reading order**. The numbered gray boxes show the order in which the Screen Reader will speak the information on the page.

2. For any item that is not in the reading order, determine whether it should or should not be spoken. For example, running headers and footers should not be spoken. Information-Type graphics should be spoken. If there are any elements on the page that are out of sequence, or otherwise mis-assigned in the reading order, see **Remediating**, below.
B) Remediating

1. Draw a box around any content that needs to be fixed.
2. Select the type of item it should be in the **TouchUp Reading Order box**.
   
   *Note:* There are useful buttons at the bottom of this box, including **Clear Page Structure** (for when the order is so off that starting over is better) and **Show Order Panel** (to show a list of pages and the order of the content for each page).
3.1.3. Lists have the correct tag structure?

A) Checking

Lists should have a tag structure in the code that is embedded in the PDF. To check the tag structure for lists:

1. Go to View... Navigation Panels... Tags.
2. Open and close elements of the tag tree using by selecting the plus and minus icons.  
   Tip: To see a corresponding highlight in the main document for any item selected in the tag tree, right click any item in the list and check Highlight Content in the pop-up menu.
3. Check that there is a list structure for each numbered or bulleted list item. The structure should include the following:
   a. A list tag <L> at the start of each list, and for each item:
   b. A list item tag <LI>
   c. A label tag <Lbl>
   d. A content tag <Lbody>
   e. The content (the text to display in the main document)
B) Remediating

If the tag structure is not properly following the content in the main document, it is likely that Screen Reader software will not read the list items properly.

- The easiest way to fix this is to go back to the original word file and Use list formatting (Section 1.1.3).
- If the original file is not available, the tag tree will have to be fixed manually. Refer to additional sources of help and guidance for instructions (See Section 3.0).
3.1.4. The tab order of pages is set?

A) Checking & B) Remediating

1. Open the **Pages tab: View… Navigation Tabs…Pages**.
2. In the **Pages** tab, select all pages (to do this, scroll up to the first page and select it, then scroll down to the last page and while holding [SHIFT], select it. A blue outline should appear around all of the pages.
3. Select **Options > Page Properties > Tab Order tab**.

![Screenshot of the Pages tab with options highlighted](image)

4. Select the radio button **Use Document Structure**.

![Screenshot of the Tab Order tab](image)

3.1.5. Artifacts are correctly placed outside of the reading order?

A) Checking and B) Remediating

Artifacts are things that should be outside of the Reading order (*See Section 3.1.2*). This includes decorative-type images, lines, running headers and footers etc.

*Note:* If the TouchUp Reading order reveals a large number of spurious elements, or elements that always get mistakenly 'corralled' into text that
needs to be in the reading order, an element can be marked as an artifact in the Tag tree:

1. Open the Tag Tree (View... Navigation Panels... Tags).
2. In the Tags tab, expand the sections to identify the element that needs to be changed (if necessary, right click an element in the tag tree and select Highlight Content to see where the elements are in the main document).
3. Select the element and right click it.
4. Choose Change Tag to Artifact from the pop-up menu.
5. If an empty container tag is left behind, delete it.

Note: In MS Word documents, text boxes are artifacts that need to be changed to regular text with style formatting. This needs to be done prior to converting to a PDF. For details, see section 1.5.4.

For documents with many artifact problems, see other sources of help and guidance (section 3.0).
3.2. Navigation

3.2.1. Bookmarks are set correctly?

A) Checking

1. Open the Bookmarks tab by selecting View… Navigation Panels… Bookmarks.
2. Review the bookmarks and determine if the bookmarks:
   a. link to the appropriate destination,
   b. are nested properly, and
   c. are labeled correctly.

Note: If Word's heading styles (Section 1.2.2) were used properly and the settings for the PDF conversion were correct (Section 2.1.1) then the PDF bookmarks should be correct.

B) Remediating

If the bookmarks are incorrect, they can either be corrected in Word, or modified in the Bookmarks tab within Acrobat.

If bookmarks are modified in the Bookmarks tab within Acrobat, those same modifications will need to be re-applied every time the document is converted from Word. It is therefore recommended that bookmarks be corrected in Word.

To modify bookmarks in Acrobat:

1. Open the Bookmarks tab by selecting View… Navigation Panels… Bookmarks.
2. Select and drag bookmarks up and down in the list of bookmarks to where they logically belong.
3. Use right clicking of bookmarks and the Options button in the Bookmarks tab to create and delete bookmarks, and change the destination of bookmarks.

3.2.2. Headings are set correctly?

A) Checking

Headings should have a tag structure in the code that is embedded in the PDF. To check the tag structure for headings:

1. Go to View… Navigation Panels… Tags.
2. Open and close elements of the tag tree using by selecting the plus and minus icons.

Tip: To see a corresponding highlight in the main document for
any item selected in the tag tree, right click any item in the list and check Highlight Content in the pop-up menu.

3. Check that there is a Heading tag with the correct level <Heading #> for each heading in the main document.

**B) Remediating**

If the tag structure is not properly following the content in the main document, it is likely that Screen Reader software will not read the headings properly.

- The easiest way to fix this is to go back to the original word file and **Use Heading Levels in style formatting (Section 1.2.2)**.
- If the original file is not available, the tag tree will have to be fixed manually. Refer to additional sources of help and guidance for instructions (**See Section 3.0**).
3.2.3. Dynamic tables of contents are working?

A) Checking

If automation was used in MS Word to create a linked tale of contents (Section 1.2.3), the links should work in the PDF after conversion.

To check if the links are working properly:

1. In Acrobat Reader go to the TOC and select the links. They should take you to the correct destination.
2. Check that the go back command (ALT+ left arrow) returns you to the TOC.

B) Remediating

If the TOC is not working properly:

- The easiest way to fix this is to go back to the original word file and Use automation if creating a Table of Contents (Section 1.2.3).
- If the original file is not available, the links and the tag tree will have to be fixed manually. Refer to additional sources of help and guidance for instructions (See Section 3.0).
3.3. **Language**

3.3.1. The Language(s) have been defined?

*Note: For more information on language switching, see *Language* (Section 1.3).*

A) Checking and B) Remediating

*Set the default document language.*

1. Select **File**… **Properties** > **Advanced Tab** > **Reading Options** > **Language**.
2. Select **English US** from the dropdown list (or other primary language as necessary).

![Document Properties](image)

*Set the language for portions of the text that use a different language from the document’s default language.*

1. Open the **Tags tab**: **View**… **Navigation Tabs** > **Tags**.
2. In the Tags tab, expand the tag tree as needed to see the elements.
3. Right click the appropriate text element, and choose **Properties** from the pop-up menu.

4. In the **TouchUp Properties** dialog box, select the **Tag** tab.
5. Select a language from the **Language** dropdown list menu.  
   *Note:* The language specified for an element also applies to all elements nested under it in the logical structure tree.
3.4. Fonts

3.4.1. Character Mappings have worked properly?

A) Checking and B) Remediating

If non-standard fonts and/or symbol characters have been used (e.g., for novel-looking bullets), then a character mapping error may come up in the Accessibility Full Check (Section 3.0).

Non-standard characters may not display correctly on a user's screen (or printout) if they do not have the specific non-standard fonts installed. The best way to avoid this is to Use System Fonts (See 1.4.1).

If non-standard characters and fonts are used, either:

- Return to the original Word document and swap out the spurious non-standard characters with characters from a standard font (See 1.4.1); or
- Treat these elements as images and add alternate text (See 3.5.1); or if the character is decorative (such as a bullet), change it to an artifact (See 3.1.5).
3.5. **Graphics / images**

3.5.1. **Alternate Text is added to Information-Type images?**

A) Checking and B) Remediating

1. Right click on any Information-Type graphic and select Edit Alternate Text from the pop-up menu.
2. Check that the Alternate Text explains the purpose and meaning of the graphic.

![Image of TouchUp Properties dialog box]

**Notes:**

- For an explanation of the different types of graphic (information, redundant and decorative), and how to add alt-text in the original MS Word document, see [Graphics / images](Section 1.5).

- If graphic objects were not grouped properly before the conversion to PDF (Section 1.5.2), then either return to the source and group the objects before conversion, or use the TouchUp Reading Order tool to corral objects as single images in the reading order (See Section 3.1.2).
3.6. Tables

3.6.1. Table Tags are set?

A) Checking

There are a number of table tags that are used in the code within PDF documents. The main ones are:

- `<Table>`: Table element—A two-dimensional arrangement of data or text cells that contains table row elements as child elements and may have a caption element as its first or last child element.
- `<TR>`: Table Row element—One row of headings or data in a table; may contain table header cell elements and table data cell elements.
- `<TD>`: Table Data cell element—Table cell that contains non-header data.
- `<TH>`: Table Header cell element—A table cell that contains header text or data describing one or more rows or columns of a table.
To check table elements, do the following:

1. Open the Tag Tree (View... Navigation Panels... Tags).
2. Expand the tags to view a table tag.

```
<Table>
  <TBody>
    <TR>
      <TH>Col 1 & Col 2</TH>
    </TR>
    <TR>
      <TH>Col 3</TH>
    </TR>
  </TBody>
</Table>
```

3. **Review the table tags to determine whether columns, rows, and cells have been correctly identified.** Select the table tag `<Table>` and verify that it contains one of the following elements:
   a. Table Rows, each of which contains Table Header `<TH>` or Table Data `<TD>` cells.
   b. `<THead>`, `<TBody>`, and `<TFoot>` sections, each of which contains Table Rows `<TR>`. (The Table Rows `<TR>` contain `<TH>` cells, `<TD>` cells, or both.)
B) Remediating

*Note:* Tables that lack well-defined borders or contain adjacent page elements are often tagged incorrectly *(see section 1.6.3).*

Poorly tagged tables can be corrected by selecting and redefining them or by splitting combined cells by creating a tag for each cell. It may be necessary to return to the original MS Word document, remove split cells and (if necessary) add well defined borders (see *section 1.5.4* for more information).

*Note:* Tables may include merged cells to create a column or row heading that straddles or 'spans' two or more associated columns or rows. In these cases, attributes for Tags may include `{ColSpan}` and `{RowSpan}`. If these attributes are not set properly, the way the table is read by Screen Reader software may be incorrect. The CommonLook plug-in for Acrobat Pro has a tool for remediating complex tables. Refer to Help in Acrobat Pro and the CommonLook manual (See *Other guidance and help, Section 3.0*).
3.7. **Links**

3.7.1. Links make sense when spoken in isolation?

A) Checking & B) Remediating

See the *Rationale* and *Testing Methods* in *Assign link names that make sense when spoken in isolation (Section 1.7.1)*.

3.7.2. Links (where possible) are on only one line of text?

A) Checking

Links that span two lines of text on the page will be (mistakenly) read twice by Screen Reader software *(see section 1.7.2)*.

Review the links on the pages to determine whether links are spanning two lines of text.

B) Remediating

If possible, fix this problems in the original MS Word document before converting to PDF. If not possible, use the following procedure to make the link speak as a single link:

1. Open the *Advanced Editing toolbar* *(View…Toolbars…Advanced Editing)*.

2. Select the *link tool*:
3. Links are highlighted:

4. Select the link box of the second part of the link and delete it.
5. Open the Content tab, find the second part of the desired link text, and move the text so that it is below the first part of the link text within the same container.

6. Delete the empty container element left behind.
3.8. **Color**

3.8.1. **High-Contrast color combinations are used?**

A) Checking

*Use Windows Operating system high contrast and high contrast reverse modes*

- See *Section 1.8.2* for details.

*View the document using Acrobat’s various high contrast modes*

1. Go to **Edit... Preferences...Accessibility**.
2. Select various **High-contrast color combinations** and review the document.

![Preferences](image)

3. Determine if all text is still readable when the document is viewed using each of Acrobat's 4 high contrast color combinations.

B) Remediating

If any problems are found with the colors used in the PDF, it will be necessary to return to the original MS Word document and fix the problems there *(See Color, Section 1.8).*
3.8.2. Color is only used redundantly?

A) Checking

See the Rationale and Testing Methods in Provide redundancy for information presented in color (Section 1.8.3).

B) Remediating

If any problems are found with the colors used in the PDF, it will be necessary to return to the original MS Word document and fix the problems there (See Color, Section 1.8).
3.9. **Document properties**

3.9.1. **Document properties are properly set?**

A) Checking & B) Remediating

Open the **Document properties dialog box** (File… Properties… Description Tab).

At a minimum, the *Title* of the document field should be set. Information added to other fields will aid in online the search-ability of the document *(see section 1.9).*
Attachments
# Word Document Accessibility Checklist

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1.1</td>
<td>Use Styles for formatting (page 19)</td>
<td></td>
</tr>
<tr>
<td>1.1.2</td>
<td>Format paragraph line spacing with styles (page 26)</td>
<td></td>
</tr>
<tr>
<td>1.1.3</td>
<td>Use list formatting (page 27)</td>
<td></td>
</tr>
<tr>
<td>1.1.4</td>
<td>Use Column formatting (page 29)</td>
<td></td>
</tr>
<tr>
<td>1.1.5</td>
<td>Do Not Use Hyphenation (page 31)</td>
<td></td>
</tr>
<tr>
<td>1.1.6</td>
<td>Do Not Use Drop Caps (page 32)</td>
<td></td>
</tr>
<tr>
<td>1.1.7</td>
<td>Convert text boxes to regular paragraphs (page 33)</td>
<td></td>
</tr>
<tr>
<td>1.2.1</td>
<td>Place document titles in the main document; not the 'Header' area (p. 37)</td>
<td></td>
</tr>
<tr>
<td>1.2.2</td>
<td>Use Heading Levels in style formatting (page 39)</td>
<td></td>
</tr>
<tr>
<td>1.2.3</td>
<td>Use automation if creating a Table of Contents (page 41)</td>
<td></td>
</tr>
<tr>
<td>1.3.1</td>
<td>Set the language properties (page 44)</td>
<td></td>
</tr>
<tr>
<td>1.4.1</td>
<td>Use System Fonts (page 46)</td>
<td></td>
</tr>
<tr>
<td>1.5.1</td>
<td>Add Alternate Text to graphics / images (page 49)</td>
<td></td>
</tr>
<tr>
<td>1.5.2</td>
<td>Group Complex Objects (page 53)</td>
<td></td>
</tr>
<tr>
<td>1.5.3</td>
<td>Place graphics / images 'in line' (page 55)</td>
<td></td>
</tr>
<tr>
<td>1.5.4</td>
<td>Avoid (or carefully control) text rendered as images (page 57)</td>
<td></td>
</tr>
<tr>
<td>1.6.1</td>
<td>Remove table formatting applied to non-tabular information (page 62)</td>
<td></td>
</tr>
<tr>
<td>1.6.2</td>
<td>Set the header row as 'repeating' (page 63)</td>
<td></td>
</tr>
<tr>
<td>1.6.3</td>
<td>Remove text wrapping around tables (page 65)</td>
<td></td>
</tr>
<tr>
<td>1.7.1</td>
<td>Assign link names that make sense when spoken in isolation (page 67)</td>
<td></td>
</tr>
<tr>
<td>1.7.2</td>
<td>Where possible, do not allow links to span two lines of text (page 68)</td>
<td></td>
</tr>
<tr>
<td>1.8.1</td>
<td>Use text colors that contrast with their backgrounds (page 69)</td>
<td></td>
</tr>
<tr>
<td>1.8.2</td>
<td>Use automatic color settings for black text and white text (page 70)</td>
<td></td>
</tr>
<tr>
<td>1.8.3</td>
<td>Provide redundancy for information presented in color (page 71)</td>
<td></td>
</tr>
<tr>
<td>1.9.1</td>
<td>Set the document title in document properties (page 73)</td>
<td></td>
</tr>
</tbody>
</table>

This Checklist is from the [SSA Guide: Producing Accessible Word and PDF documents](#), Version 2.1, April 2010. Produced by the Social Security Administration Accessibility Resource Center.
PDF Document Accessibility Checklist

*Note: Before you start this checklist, ensure that the Word document checklist has been passed. Fix any problems in the Word document before converting it to a PDF.*

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1.1</td>
<td>Configure Conversion Preferences (page 80)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>2.1.2</td>
<td>Convert the document with the 'PDF Maker' application in Word (p. 85)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.1.1</td>
<td>The initial view is set properly? (page 94)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.1.2</td>
<td>The reading order is correct? (page 96)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.1.3</td>
<td>Lists have the correct tag structure? (page 98)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.1.4</td>
<td>The tab order of pages is set? (page 100)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.1.5</td>
<td>Artifacts are correctly placed outside of the reading order? (page 100)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Bookmarks are set correctly? (page 102)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Headings are set correctly? (page 102)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Dynamic tables of contents are working? (page 104)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.3.1</td>
<td>The Language(s) have been defined? (page 105)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.4.1</td>
<td>Character Mappings have worked properly? (page 107)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.5.1</td>
<td>Alternate Text is added to Information-Type images? (page 108)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.6.1</td>
<td>Table Tags are set? (page 109)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.7.1</td>
<td>Links make sense when spoken in isolation? (page 112)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.7.2</td>
<td>Links (where possible) are on only one line of text? (page 112)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.8.1</td>
<td>High-Contrast color combinations are used? (page 114)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.8.2</td>
<td>Color is only used redundantly? (page 115)</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>3.9.1</td>
<td>Document properties are properly set? (page 116)</td>
<td></td>
<td>[ ]</td>
</tr>
</tbody>
</table>

This Checklist is from the **SSA Guide: Producing Accessible Word and PDF documents**, Version 2.1, April 2010. Produced by the Social Security Administration Accessibility Resource Center.
Reader's Notes
Copyright statement and suggested citation

This guide is public information and may be freely copied. Electronic and paper copies should not be modified from the source without prior written permission from the authors. To cite the work in this guide, use the following information: